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User Manual Philips MultiOne Workflow

1 Introduction

1.1 System requirements

The minimum system requirements for using MultiOne can be found in the MultiOne
user manual.

1.2 Working with the various MultiOne interfaces

A description of the various MultiOne interfaces can be found in the MultiOne getting
started and the MultiOne user manual.
Note: MultiOne Workflow only supports the USB2DALI and SimpleSet interfaces.

1.3 Assumed knowledge

To be able to use MultiOne Command Line basic programming skills and a basic
understanding of MS-DOS commands is assumed.
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3 Attention points

3.1 General

Before starting MultiOne Workflow, make sure that the correct interface (USB2DALI or
SimpleSet) has been connected to your computer.

When upgrading the Windows Operating System, make sure the connection settings
are correct when using MultiOne again.

When starting multiple instances of MultiOne Workflow for parallel configuring, make
sure every instance of MultiOne Workflow uses another interface. The unique id of an
interface is shown in the Connection Settings window where the interface port/reader
is selected. Also, for the currently selected interface the unique id can be found in the
About box and in the tooltip of the connection status indicator in the status bar at
the bottom-right part of MultiOne Workflow.

When multiple devices are connected to a laptop (e.g SimpleSet interface, barcode
reader) it might be that the laptop does not provide enough power to the USB ports.
Connect the laptop to the power adapter and change the power profile to "high
performance”. If connected devices then still can’t be found, try connecting them
through a powered USB hub.

When MultiOne Workflow is running on a laptop. Speed improvements can
sometimes be gained by connecting the laptop to the power adapter and changing
the power profile to "high performance”.

3.2 DALI

Lighting applications with DALI devices can be seriously affected by the
presence/absence of the DALI short address. Make sure the DALI short address is as
you expect, after finishing working with MultiOne.

3.3 SimpleSet interface

For SimpleSet there are three interfaces which can be used for communication (see
the MultiOne user manual): the Philips LCN9610, LCN9620 or LCN9630 MultiOne
interface SimpleSet.

3.4 Label printer

MultiOne Workflow supports so called ‘Direct printing’, which means that a specified
printer is used to print a label containing the selected label fields after successful
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configuration. This functionality however requires that a supported label printer is
available on the system where MultiOne Workflow is running.

The following printers are officially supported:

e Dymo LabelWriter 450 Turbo
o Zebra GX430t

Please use the documents provided with your label printer to properly connect and
install the label printer on the system where MultiOne Workflow is running. After a
successful installation on the system which can be tested using the software provided
by the printer manufacturer, the printer can be configured in MultiOne Workflow to
be used for direct label printing.

Note! If multiple printers of the same type are connected to the system, Windows will
list them with reference numbers. (E.g. Zebra GX430t, Zebra GX430t 1)
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4  Starting with MultiOne Workflow

4.1 Warning

To be sure that the correct feature configuration file is used, it is strongly advised to
use the latest version of MultiOne Engineering to create a feature configuration file.
4.2 Preferences

To change the preferences, you need to start Workflow. In case an error occurred
while reading the preferences file on startup, an error screen will appear as shown
below.

239: An error occurred while loading the Workflow preferences, please update and confirm all your preferences.

Exit

Changing the preferences can be done by going to the Tools->Preferences menu.
Please make sure to check all the preferences before saving.

The preferences menu exists of multiple tabs that contain the different preferences
options. All preferences can be saved or discarded at once by pressing the OK or the
Cancel button respectively.
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4.2.1 General
Within the General tab you can:

e change the startup behavior
e select the application language

General preferences

General [] Start maximized on startup

File locations

Selected language: | English v
Configuration

Takes effect once MultiOne Workflow is restarted
Label print

Barcode reading

Data logging

4.2.1.1 Starting Maximized
When the Start maximized on startup is selected the application will start up in full

screen mode.

4.2.1.2 Application language

To configure the application language, a selection can be made from a set of pre-
defined languages. A restart of the application is required to be able to use the new
language setting.

4.2.2 File locations
Within the File locations tab you can:

e select the supported devices file
e select the scheduler file location
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File locations preferences

General Supported devices file location:
File locations
Configuration Scheduler file location:
Label print
Barcode reading
Data logging

o W e

4.2.2.1 Supported devices configuration

To make sure only supported devices can be configured, a supported devices file can
be created. The created file can be placed in any location on the pc and is used by
selecting it via the corresponding Browse button.

To learn how to use this supported devices file see chapter: 8 The supported devices
file

4.2.2.2 Scheduler file execution

The scheduler file contains a series of DALI commands which were already created
using MultiOne and saved on the PC. This scheduler file will then be executed on a
connected device. The scheduler files gets executed just after writing the feature data
to connected device. The scheduler file will be the same for MultiOne Workflow and
MultiOne Command Line.

MultiOne Workflow accepts two scheduler file formats: MOS and XML. The created
file can be placed in any location on the PC and is used by selecting it via the
corresponding Browse button.

Note! Scheduler file location can only be selected when using a DALI interface.

4.2.3 Configuration
Within the Configuration tab you can:

e Choose between the usage of the local preferences or from a workflow
configuration file
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e if "Use Local Preferences” is selected then multiple configuration parameters
can be changed. Chapter 7 workflow configuration file explains the

parameters.

o if "Use workflow config file" is selected, then the workflow configuration file
can be loaded.

e select different configuration mode

e allow or prevent duplicate configuration of same device in a batch
configuration

e enable or disable displaying the features that are written during configuration

Configuration preferences

General () Use Local Preferences

File locations | Check device model (DALI or SimpleSet)
Device info must be included in the Featurs Ale

| DALI verify

| DALI identify always

Configuration

Label print

Barcode reading DALI multiple device

Data logging DALI check device present
DALI commission all

| DALI factory new

®) Use workflow config file

File location:
C:\Temp\WorkflowConfig.txt
Configuration mode: | Unlimited v

[ Prevent duplicate device/driver configuration

[] Display pregrammed feature(s) during programming/configuration

ECEE T

4.2.3.1 Workflow configuration

To configure Workflow, a configuration file template is located in: {Your install
location}\ WorkflowConfig-TEMPLATE.txt. This file can be used as a template to create
your own configuration file. The created file can be placed in any location on the pc
except in the installation location or its child directories. In order to specify the
location of the Workflow configuration file, the location can be selected via the
corresponding Browse button.

To learn how to use this configuration file see chapter: 7 The Workflow

configuration file

4.2.3.2 Specifying the configuration mode

If Batch size is selected in the Configuration mode, MultiOne Workflow allows users
to specify the number of devices to configure with a given feature file. MultiOne
Workflow will keep track of progress during configuring. When all devices have been
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configured, the current batch will be completed and a new feature file can be
selected.

If Unlimited is selected in the Configuration mode, an infinite number of devices can
be configured with a given feature file. To select a new feature file click Cancel batch
at any time.

To learn how to enter the batch size see chapter: 5.4 Entering the number of
devices

If Single shot is selected in the Configuration mode, an infinite number of devices
can be configured with a new file each time. To end single shot programming, click
Cancel batch at any time.

How single shot programming influences the flow will be explained in each relevant
chapter.

4.2.3.3 Prevent duplicate device/driver configuration

If Prevent duplicate device/driver configuration is checked, MultiOne Workflow
will check the unique id of a device before configuring it. When the device was
already configured in the current batch, a message will be shown indicating that the
device was already configured.

Notice! DALI device without unique identifier will NOT support this feature.

4.2.3.4 Display programmed feature(s) during programming/configuration

If Display programmed feature(s) during programming/configuration is checked,
MultiOne Workflow will display all features that are written to the device during
configuration on the screen.

4.2.4 Label print
Within the Label print tab you can:

e enable or disable direct printing
o select the printer to use for direct printing
o select the label fields to print on the directly printed label
e enable or disable indirect printing (generating label data)
o enable or disable specific label data
o enable or disable including the device identifier into the label data
o select the label data location
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Label print preferences

General [] Direct printing
File locations Printer =

Configuration
Select label fields

| AOC (output current)

Label print
Barcode reading
. | Custom field 1
Data logging | Custom field 2
+| Date
/| Device unique ID
| Version

+| QR code

[] Indirect printing (generate label data)
Use custom fields

Include device identifier

Loecation:

4.2.4.1 Direct printing

If Direct printing is enabled, MultiOne Workflow will print a label containing the
selected label fields with its value on the selected printer directly after every driver
configuration. To be able to successfully directly print a label, a supported printer
must be connected the system and selected in the MultiOne Workflow preferences.
Next to that, at least one label field must be selected in the preferences.

Chapter 3.4 Label printer describes which label printers are officially supported by
MultiOne Workflow and which information to use to install them on the system.

The Printer drop-down lists all available printers on the system and gives the user
the opportunity to select the printer to be used for direct label printing. Any known
printer can potentially be used for printing, however MultiOne Workflow only
officially supports the printers as mentioned in chapter 3.4 Label printer.

The sub-settings can only be used when Direct printing is enabled.
Note! A label will not be printed unless the configuration succeeds.

4.2.4.2 Direct printing label fields
If Direct printing is enabled, it's possible to specify the label fields to be printed on
the label after successful configuration.

When AOC (output current) is selected, the configured AOC output current is added
to the printed label only if the AOC feature was part of the configuration.
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By enabling Custom field 1 and/or Custom field 2, MultiOne Workflow lets you
specify 1 or 2 extra values that will be added to the printed label data.

Note! Only the first 18 characters of the entered custom fields will be added to the
printed label data.

To learn how to enter the custom fields see chapter: 5.3 Entering the custom fields
When Date is selected, the actual configuration date is added to the printed label.

If Device unique ID is selected, MultiOne Workflow retrieves the device identifier
from the device and adds it to the printed label.

By enabling the Version, the version of the device is added to the printed label.

If the QR code is selected, a QR code is added to the printed label containing the
device identifier retrieved from the device.

4.2.4.3 Indirect printing (generate label data)

If Indirect printing (generate label data) is enabled and the Location field is filled
in with a valid folder, MultiOne Workflow will generate and export label data (after
every driver configuration) to this folder.

The generated label data is stored into a comma separated value file. The filename is
constructed using the device name and the date and time the label data was
generated. For detailed information about the content of the label data file see
chapter: 10 Label data file contents

The sub-settings can only be used when Indirect printing (generate label data) is
enabled.

Note! Label data file will not be generated unless the configuration succeeds.

4.2.4.4 Generate label data fields
If Use custom fields is enabled, MultiOne Workflow lets you specify 2 extra values

that will be added to the exported label data.
To learn how to enter the custom fields see chapter: 5.3 Entering the custom fields

By enabling Include device identifier MultiOne Workflow retrieves the device
identifier from the device and adds it to the exported label data.

4.2.5 Barcode reading
Within the Barcode reading tab you can:
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e enable or disable barcode reading for automatic file retrieval
e select the location of the feature files which are associated with the defined

barcodes
Barcode reading preferences
General [] Use barcode reader for automatic file retrieval
File locations File location:

Configuration
Label print
Barcode reading

Data logging

ECEE T

4.2.5.1 Automatic retrieval of files using a barcode reader

If Use barcode reader for automatic file retrieval is checked, MultiOne Workflow
will run in barcode reading mode meaning you can scan a barcode to automatically
open its associated file. In normal mode the feature file is selected by clicking the
‘Open..." button.

To configure where the files (which are associated with the barcodes on the devices)
are located, browse for or fill in the location of the files at the File Location field.

By the combination of the configured location and the filename which the barcode
resembles MultiOne Workflow can load the file.

The screenshot below shows the startup screen when in barcode reading mode.
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- 3
Philips MultiOne Workfiow 3.0 3 Lo 50

Eile Toecls Help

MultiOne =
Workflow =

Using write & verify: no
Identify: only once

Multiple device configuring: no
Commission all: no

Check device model: no

DALI factory new: yes

Check device present: no

Scan the barcode on the device when you are in this screen. When the barcode was
scanned successfully and the file is loaded, MultiOne Workflow continues with the
configuration workflow.

4.2.5.2 Use barcode scanning combined with single shot
When barcode reading is used in combination with single shot in DALI protocol,
the user can scan the barcode to load either the schedule file or the feature file.

There could be a case where there are two files with the same name but different
extension in the provided folder. In this case, Workflow will show an error.

For more information about how to setup a barcode reader and how to generate the
barcodes see chapter: 9 Barcode reader and barcode requirements

4.2.6 Data logging
Within the Data logging tab you can:

e enable data logging

e select the location where the data logging files need to be placed

o select the frequency of the files

e enable to use custom fields for data logging

e enable to read device information (this will take extra time during
configuration)
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Data logging preferences

General [] Generate logging
File locations Logging file location:
Configuration

Label print

Barcode reading File generation frequency:  Per device

Data logging Use custom fields

Include device properties

Custom fields and device properties will not be
available when a scheduler file is selected in Single
shot mode.

4.2.6.1 Data logging

Data logging is a way to track the configuration of features, the MultiOne Workflow
and device information. Device information is only provided when the option is
selected and will result in a slower configuration time (more data will be read from
the device).

If Generate logging is enabled and the Logging file location field is filled in with a
valid folder, MultiOne Workflow generates logging, in this folder, after every
successful driver configuration.

The File generation frequency can be used to change the data logging period.

If Use custom fields is enabled, MultiOne Workflow lets you specify 2 extra values
that will be added to the exported logging file.

If Include device properties is enabled, MultiOne Workflow reads additional device
information from the device for logging purposes.

When enabled, xml files are generated in the specified location for the specified
period (per device, batch, day, week or month). The date and time format used is UTC
(Coordinated Universal Time).

Examples:
Device HF-Ri TD 12 26-42 PL-TC E+-20160715T064806.xml
Batch: Batch-20160715T064910.xml
Day: Day-197-20160715T064933.xml
Week: Week-28-20160715T065004.xml
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Month: Month-7-20160715T065027 .xml

Note that if SingleShot is selected as configuration mode, then select Use custom
fields or Include device properties will not have an effect if the user select a
scheduler file from the main screen.
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5 MultiOne Workflow

5.1 Connection settings

Before you start working with MultiOne Workflow you will need to set the connection
settings. On first start MultiOne Workflow will detect what interfaces are connected to
your PC or laptop.

e When only one interface is connected this one will be automatically chosen.
e Otherwise the Connection Settings window will appear.

Whenever MultiOne Workflow is started again and a previously selected interface is
not connected anymore the following selection or action will take place:

e When only one interface is connected (independent of the type of interface)
this one will be automatically chosen.

e When two interfaces are connected and one of them is of the same type as the
previously selected interface this interface is automatically selected.

e Otherwise the Connection Settings window will appear.

Connecting multiple similar SimpleSet interfaces is currently only supported when
using a FEIG interface.

5.1.1 Changing the connection settings
To change the connection settings go to Tools = Connection settings... This option
is only available on the main application window.

- Bl
o) Connection seﬂl_ngs—. @M

@iDALE ©) SimpleSet

Selected interface [MultiOne DALI interface v]

Selected port [1?&?1?29400?

Choose the protocol you want to use, DALI for the USB2DALI interface and SimpleSet
for the SimpleSet interface.

Then, select the interface. When a DALI interface is selected or when a FEIG interface
is selected as SimpleSet interface, then also the selected port/reader (depending on
the interface) can be selected.
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For both protocols the unique id of the interface is shown (when available). This, to
be able to identify which interface is used by which MultiOne instance (when
configuring devices in parallel using multiple instances of MultiOne).

When a selected interface contains an outdated firmware version, MultiOne will show
a message that it is unable to connect to the selected interface:

,

MultiOne can't connect to the selected interface because its firmware version
(02.03.00) is outdated.

=

5.2 Opening a Workflow file
F Philips MultiOne Workflow 3.0 @M‘

File Tools Help

MultiOne S
Workflow N4

Using write & verify: no

Identify: only once

Multiple device configuring: no

Commission all: no

Check device model: no

DALI factory new: yes Open file...
Check device present: no —

DALI @®

Feature file and schedule file are both Workflow files. If the DALI protocol is used
and the configuration mode is Single shot, then Workflow accepts both type of
Workflow files. Otherwise, Workflow will only accept feature files. To open a file,
select File > Open... or click Open file... . Select a file and click Open.

If in the preferences the option Display features that are written during
configuration was checked, MultiOne Workflow will display all features that are
written to the device during configuration in the upper section of the screen. This
information is visible throughout the whole configuration sequence as depicted in
the following picture.
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~
Philips MultiOne Werkflow 3.0 BT

File Toocls Help

File: C:\workspace\featurefile.xml
Device: Xitanium 17W 0.3-1A 24V TD/Is 230V 1.3
Features: AOC, CLO

Connect a device.

Cancel batch

5.3 Entering the custom fields
(B prips Mutione worton

File Tools Help

C:\Workspace\Xitanium 36W.xml

Custom field 1

Custom field 2

Cancel batch

If in the preferences the option Use custom fields, Custom field 1 or Custom field
2 is checked, MultiOne Workflow will display a window in which one or two custom
fields can be filled in. These fields will be stored as part of data logging, together with
the generated label data and/or will be printed on a label (depending on the selected
options).

Click OK to continue.
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5.4 Entering the number of devices

Pl e ki [E=REEN )
Eile Tools Help
N

File: C:\Workspace\featurefile.xml|

Device: Xitanium 17W 0.3-1A 24V TD/Is 230V 1.3

Enter number of devices to configure: 1

Cancel batch

If in the preferences the configuration mode was set to Batch size, MultiOne

Workflow will display a window in which the number of devices for this batch can be
entered. The minimum number of devices is 1.

If the loaded feature file contains device information it will be shown (see screenshot
above).

Click OK to continue. MultiOne Workflow will now keep track of batch progress
during configuring (the amount of successfully configured devices is shown against
the amount of devices to configure).
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5.5 Connect a device / Waiting for device

5.5.1 Connect a device (USB2DALI interface)

Eile Tocls Help

File: C:\workspace\features.xml

Connect a device.

Cancel batch

Use Cancel batch to go to the main application window. Click OK to continue. When
OK is clicked and no device is connected, the following window will appear:

File: C:\Workspace\features.xml

100: No connected devices were found

Cancel batch
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Connect a device and click Retry to try again, or click Cancel batch to go to the main
application window.

5.5.2 Waiting for device.... (SimpleSet interface)

Eile Tocls Help

File: C:\workspace\features.xml

Waiting for device...

Cancel batch

Use Cancel batch to go to the main application window. To continue hold the

SimpleSet ®

SimpleSet interface close to the device.
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5.6 Device connected / Device found

In case of USB2DALI: a device was connected and OK was selected.
In case of SimpleSet: interface was moved close to the device.

The following windows will appear:

& Multione Workflow
File Tocls Help

||
File: C:\workspace\features.xml

Identifying...

Cancel batch

After successful identification, the following window will appear:

File: C:\workspace\features.xml
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When the features have been successfully written, the following window will appear if

label printing is enabled:
(B Philips MultiOne Workiiow (=] o [

File Tools Help

File: C:\workspace\FeatureFiles\Aoc.xml

Connected: Xi SR 75W 0.3-1.0A SNEMP 230V 5240 sXt

Exporting label data...

F ﬁ
When a scheduler file is being executed then the following screen will appear if
schedule file exists in the preferences under the scheduler file location:

T S L = |

File Toals Help
—

File: D:\Feature File\xitanium40w_feature.xml
Schedule: D:\Schedule\schedule.mos
Device: Xitanium 40W 1.1A 54V DALI SR INT 1.2

Connected: Xitanium 40W 1.1A 54V DALI SR INT

Executing schedule...

When feature data has been written and the schedule has been executed the

following screen will appear:
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' & Philips Multione Workflow
| File Tools Help
——

File: D:\Feature File\xitanium40w_feature.xml
Schedule: D:\Schedule\schedule.mos
Device: Xitanium 40W 1.1A 54V DALI SR INT 1.2

Connected: Xitanium 40W 1.1A 54V DALI SR INT

Done. Connect the next device.

Cancel batch

DALl @
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5.7 Configuring done (USB2DALI interface)

After successfully configuring the device, audible feedback can be heard and the
following window appears:

Eile Tools Help

File: C:\workspace\features.xml

Done. Connect the next device.

v

Cancel batch

Disconnect the device and connect a new device. Click OK to configure the new
device.
Click Cancel batch to go to the main application window.
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5.8 Remove the device (SimpleSet interface)

After successfully configuring the device, audible feedback can be heard and the
following window appears:

Eile Tools Help

File: C:\Workspace\features.xml

Done. Remove the device...

v

Cancel batch

SimpleSet ®

Move the SimpleSet interface away from the device, MultiOne will then show the
waiting for device view as explained in 5.5.2

Click Cancel batch to go to the main application window.
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5.9 Single shot programming with a new file

If the configuration mode is set to Single shot and Barcode reading is disabled,
Workflow will allow users to select a new file after removing the device.

F
Philips MultiOne Warkflow (=[O [t

File Tools Help

Open file...

Cancel batch

If the Barcode reading is enabled, then the following screen will appear.

(B ehitips Muttione Workfiow (= [iE
File Tools Help
]|
Cancel batch

Copyright © 2019 Signify Holding. All rights reserved. Page 30 / 57



User Manual Philips MultiOne Workflow

5.10 Configuring failed

When configuring failed, an audible feedback can be heard and the following window
appears (This is for both USB2DALI and SimpleSet interface):

File: C:\workspace\aoc.xml
Device: Xi LP 40W 0.3-1.0A SL 230V S175sXt 1.1

Connected: Xi LP 40W 0.3-1.0A SL 230V 5175 sXt

233: Write failed.

ety B od Sio_

Cancel batch

SimpleSet @®

To retry the same device, click Retry.
To skip configuring, disconnect the device, connect a new device and click Skip.

Click Cancel batch to go to the main application window.
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5.11 Configuring finished

At any time during configuring, click Cancel batch to go to the main application

window.

If in the preferences the option Enter batch size before configuring was checked
and the specified number of devices have been configured correctly, MultiOne
Workflow will indicate that the batch is finished. Note that devices that could not be
configured correctly (and were skipped by the user) will not be counted for the batch

progress.

-
Philips MultiOne Weorkflow i

Eile Tools Help

File: C:\workspace\FeatureFiles\Aoc.xml

2/2

Connected: Xi SR 75W 0.3-1.0A SNEMP 230V 5240 sXt

Batch finished.

| Finish batch

Click Finish batch to go to the main application window.

Select File & Exit or click Close to exit MultiOne Workflow

F
Philips MultiOne Workflow 3.0

Eile] Tools Help

PHILIPS
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5.12 Possible errors before or during device configuration

In case an error occurs before or during device configuration, this is made visible to
the user by displaying a red text on the screen. This chapter describes some of these
error scenarios.

5.12.1 Database file does not exist
After startup or successful identification, the following window will appear in case the
database file is missing:

225: A database error occurred. Please re-install MultiOne Workflow.

Exit

Click Exit to close the application window and re-install the MultiOne Workflow.
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5.12.2 Scheduler file does not exist

If the scheduler file does not exist at the mentioned location (Tools-> Preferences -
> File locations -> Scheduler File location) then it shows the following error just
after closing the “Preferences” window:

214: A part of the path of the scheduler file location could not be found: C:\Workspace\TestSchedule.mos

Exit

5.12.3 Scheduler file is not valid
If the configured or loaded scheduler file is not valid or incorrect format then just
after identifying the connected devices it shows the following error:

File: C:\workspace\feature.xml
Schedule: C:\workspace\schedule.mos

148: The scheduler file is incorrect.

Exit
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5.12.4 Scheduler file contains an infinite loop
If the configured or loaded scheduler file contains an infinite loop then just after
identifying the connected devices it shows the following error:

File: C:\workspace\feature.xml
Schedule: C:\workspace\schedule.mos

147: The scheduler file contains an infinite loop.

Exit
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5.12.5 Data logging doesn’t support multiple device configuring

If a Workflow configuration file is loaded with multiple device configuring enabled
and data logging is enabled (Tools-> Preferences -> Data logging) then it shows
the following error just after closing the “Preferences” window:

204: Data logging is not supported in combination with multiple device configuring

Exit

5.12.6 Data logging location incorrect
In case an incorrect data logging location is provided, the following error is shown:

220: The data logging file location could not be created: E:\Workspaces

EXit
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5.12.7 OEM Write Protection password is invalid

When using SimpleSet, MultiOne Workflow verifies the password (when a password is
provided in the feature configuration file) with the password that is currently set in
the driver. When a mismatch takes place, the following error will be shown:

File: C:\Workspace\features.xml
Device: Xitanium 40W 1.1A 54V DALI SR INT 1.5

Connected: Xitanium 40W 1.1A 54V DALI SR INT

113: OEM Write Protection is enabled in the device, but no password was provided in the feature file

Retry

Cancel batch

SimpleSet ®
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5.12.8 Duplicate device configuration

When using MultiOne Workflow, the application will check (depending on the setting
in the preferences screen) if the currently connected device was already configured
during the current flow. If the device was already configured, the following message
will be shown:

Connected: EasySense

130: This device already contains this configuration.

Cancel batch

Please do note that DALI device without unique identifier will NOT support this

SimpleSet ®

feature.
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5.12.9 Partial device configuration after earlier configuration failure

When using SimpleSet, MultiOne Workflow will check if the device can be configured
correctly with the provided feature file. If the configuration of the device failed
during a previous configuration session and in this session a feature file is provided
to configure the device partially, the following message will be shown:

File: C:\Workspace\features.xml
Device: Xitanium 40W 1.1A 54V DALI SR INT 1.5

Connected: Xitanium 40W 1.1A 54V DALI SR INT

121: Unable to configure the device correctly with the given feature file.

SimpleSet ®

Cancel batch

Use MultiOne to identify and resolve the problem.
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5.12.10 Multiple device configuring with different devices

It is possible, when using MultiOne Workflow, to verify all written devices after
multiple device configuring. This requires the programmed devices to be the same.
The application will check the name and the version of the connected devices. If the
devices are not all the same, then the following error will appear:

Device: Xi LP 40W 0.3-1.0A SL 230V S175 sXt 1.1

Connected: Xitanium 50/75W 0.3-1A 62V TD/TE 230V

242: The connected devices are not the same

Cancel batch
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5.12.11 Direct printing selected printer not connected
When using direct printing, if the selected printer is not connected to the system, the

following error is shown:

247: The selected printer "ZDesigner GX430t" is not connected.

Exit

SimpleSet @®

Please select a connected printer or disable direct printing in the MultiOne Workflow

preferences.
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5.12.12 Direct printing no label field selected

When using direct printing with a connected printer, however no label field is
selected, the following error is shown:

248: Direct label printing is enabled, however no label content is selected. Please make sure the desired label content is selected.

SimpleSet @®

Please select one or more label fields for direct printing to continue or disable direct
printing.

5.12.13 Indirect printing invalid location selected
In case an incorrect label data location is provided, the following error is shown:

217: It is required to configure the data folder when generate label data is enabled.

Exit

SimpleSet @

Copyright © 2019 Signify Holding. All rights reserved. Page 42 / 57



User Manual Philips MultiOne Workflow

6 MultiOne Command Line

MultiOne Command Line only runs from the Windows command line (console, MS-
DOS prompt).

MultiOne Command Line is installed in the same directory as MultiOne Workflow.

6.1 Parameters

MultiOne Command Line is started using the following syntax:
MultiOneWorkflow.exe /f FeatureFile /w WorkflowFile [/p Protocol] [/v
Verbosity] [/c ContinueOnRecoverableErrors] [/l LabelDataLocation] [/lu
IncludeUniqueldinLabelData] [/d SupportedDevicesFile] [/id Uniqueld]

Or when using a schedule the following syntax:
MultiOneWorkflow.exe /s SchedulerFile /p d [/v Verbosity] [/c
ContinueOnRecoverableErrors] [/d SupportedDevicesFile] [/id Uniqueld]

Note: The scheduler only works with DALI protocol.
Note: When both /f and /s are used, the /f option will be ignored.
Note: When /f is used, then /w has to be provided as well.

Or when retrieving the list of available DALI or SimpleSet interfaces:
MultiOneWorkflow.exe /il Interface [/v Verbosity]

Parameters between brackets are optional.

When a parameter is ignored because of other parameters, a warning is displayed.
E.g. when both /s and /f are used.

The parameters have the following meaning:

Option Parameter Meaning

/f FeatureFile Path to the feature configuration file

/w WorkflowFile Path to the workflow configuration file, see 7
The Workflow configuration file

/p Protocol The protocol used for communication.
Possible values:
d USB2DALI (default)
s SimpleSet

/v Verbosity The verbosity level (the message types that are

shown in the console)
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/c

/s
/d

/l

/lu

/il

/id

/dll

/dif

/didp

/identifyonly

Copyright © 2019 Signify Holding. All rights reserved.

ContinueOnRecoverableErrors

SchedulerFile
SupportedDevicesFile

LabelDatalocation

IncludeUniqueldinLabelData

Interface

Uniqueld

Data logging location

Data logging generation
frequency

Data logging device
properties

IdentifyOnly

Possible values:

info Show info, warning, error and
fatal messages (default)

warning Show warning, error and fatal
messages

error Show error and fatal messages
fatal Show fatal messages only
Whether MultiOne should halt on recoverable
errors or ignore them and continue.

Possible values:

continue Continue on recoverable errors
halt Halt on recoverable errors and
produce an error code (default)

Path to the scheduler file

Path to the supported devices file, see 8 The
supported devices file

The location where to store the generated label
data

Include the unique ID of the device in the
generated label data

true include

false not include (default)

The MultiOne interface type for which to retrieve
the list of available interfaces (with their unique
id).

Possible values:

d USB2DALI interface (default)

s SimpleSet interface

The unique id of the interface to use for
communication (retrievable using the /il
command line parameter).

Notice! It is recommended to use the /p
command line parameter to specify the interface
type.

The location where the files will be placed

Does not work with scheduler files

The frequency of file creation

device for every device a file will be created
day for every day a file will be created
week for every week a file will be created
month for every month a file will be created
This option is only used in combination with the
/dll option.

When set to true device properties will also be
read out during configuration

true

false

This option is only used in combination with the
/dll option.

When set to true, device will be read out and the
device info will be displayed.
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Possible values:
true
false

Example usage:

MultiOneWorkflow.exe /f “c:\files\FeatureConfiguration.xml” /w
“c:\files\WorkflowConfiguration.xml” /p d /id 1A2B3C4D5E®6 /I “c:\labels” /v
fatal /c halt

6.2 Exit codes

In addition to console output, MultiOne Command Line produces an exit code when
terminating. These codes can be used to integrate MultiOne Command Line into a
custom tool chain. The exit codes are listed in the following sections.

6.2.1 General

Exit code Meaning

0 Success

1 User software key not activated

4 Verification failed

5 The protocol provided as argument to the command line
is wrong

6 Multiple interfaces connected, making a choice is required

(look at the /id argument)

7 Specified interface (/id) is not connected
Workflow configuration file not found

10 Workflow configuration file contains invalid parameter
combinations

11 Workflow configuration file not specified

12 The default template is used as Workflow configuration
file

13 Mandatory settings are missing in the Workflow
configuration file

14 A Workflow configuration file is used which is located in
the installation directory

15 Invalid arguments combination

16 Duplicate arguments

20 Supported devices file not found

21 Supported devices file not valid

30 Label data folder could not be created

31 Label data could not be generated

32 Label data could not be exported

-1 General application failure

6.2.2 Related to writing feature data

Exit code Meaning
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101 There are no features to write (there are no features in the
feature file matching the features in the device)
102 Writing failed

6.2.3 Related to resetting the short address of a device

Exit code Meaning
150 Resetting the short address of the device failed
151 The DALI factory new operation failed

6.2.4 Related to selecting a feature file

Exit code Meaning

200 Feature file not present

201 Invalid feature configuration file

202 Feature configuration file is empty

203 Feature configuration file contains duplicate features
204 The feature file contains an unsupported feature

6.2.5 Related to device features and feature file

Exit code Meaning

300 The device does not support all features from the feature
file

301 The device is not of the model specified in the feature file

302 Configuration mismatch, the device was configured
incorrectly. Please use MultiOne to identify and resolve the
problem.

346 OEM Write Protection is enabled in the device, but no
password was provided in the feature file

347 The connected device indicates OEM Write Protection, but it
isn’t available in current device.

348 Failed to set the OEM Write Protection password.

349 The OEM Write Protection password stored in the feature

file is not required to program the device. Remove the
stored OEM Write Protection password from the feature file.

350 The OEM Write Protection password stored in the feature
file does not correspond with the password in the device.
351 The ALO min value stored in the device is higher than the

ALO value in the feature file.

6.2.6 Related to traceability

Exit code Meaning

400 Writing traceability information failed

6.2.7 Related to identifying a device

Exit code Meaning

500 No device found

501 Too many devices found

502 Unable to execute discover (There is a problem with the

connection settings / connected devices. Check if the
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correct connection settings being used and the MultiOne
interface is connected properly)

503 Multiple devices share the same short address

504 Unsupported device detected

506 The connected devices are not the same

507 The connected device uses an unsupported version of the
Write Protection feature

508 The connected device is not in the custom supported

devices list.

6.2.8 Related to converting a feature file

Exit code

Meaning

600

The feature file provided does not contain any features

6.2.9 Related to reading feature data

Exit code Meaning

650 There are no features to read (there are no features in the
feature file matching the features in the device)

651 Reading failed

6.2.10 Related to system preparation

Exit code

Meaning

700

No interface connected

6.2.11 Related to converting feature data

Exit code

Meaning

800

The feature file provided could not be converted to the
latest version

6.2.12 Related to the scheduler

Exit code Meaning

200 The provided scheduler file is invalid and could not be
loaded.

9201 The provided schedule contains an infinite loop.

902 The provided schedule could not be executed.

6.2.13 Related to the database

Exit code

Meaning

1000

6.2.14 Related to data logging

The database file is not found. Please re-install MultiOne
Workflow.

Exit code Meaning

1100 The location supplied is not a valid location

1101 Data logging tried to create a file but it already exists

1102 Data logging tried to append a file, but the file was not a
valid xml file

1103 Data is not supported with multidevice configuring, disable
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6.2.15 Related to policies

Exit code Meaning

1200 “Local Security Setting System cryptography: Use FIPS
compliant algorithms for encryption, hashing and signing"
is set to enabled. Please contact your administrator to
disable this policy.

6.2.16 Related to verifying

Exit code Meaning
1400 Failed to verify the device
1401 There are no features to verify

6.2.17 Related to file validation

Exit code Meaning

1500 The quantity of drivers should be more than 0.

6.2.18 Related to writing feature data

Exit code Meaning

1600 Unable to configure the device correctly with the given
feature file.

1601 Communication error has occurred, please try again.

1602 Connection error has occurred, please check your
connection.

1603 Recovering the device failed.

6.2.19 Related to general communication

Exit code Meaning

1700 Communication failure, please try again.

6.2.20 Related to SimpleSet communication

Exit code Meaning

1800 Communication failure, please try again.
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7 The Workflow configuration file

The workflow configuration is the same for MultiOne Workflow and MultiOne
Command Line. The configuration file contains the following options:

Parameter Meaning

checkdevicemodel When enabled MultiOne Workflow will check if the connected device
matches the device model that is included into the feature
configuration file and raises an error if they do not match. If the
feature configuration file does not contain any information about the
device model (files created with MultiOne 2.6.5 or older) an error will

be raised.
true checkdevicemodel is enabled
false checkdevicemodel is disabled
DALlverify When enabled MultiOne Workflow will perform a Write & Verify while
configuring the devices. When disabled only a Write will be
performed.
true DALlverify is enabled
false DALlverify is disabled
DALlidentifyalways When enabled Workflow will identify every device; otherwise it will

identify only once. Disabling will increase the speed of the configuring
process. (The assumption in the latter case is that MultiOne Workflow
is used to consecutively configure a batch of devices of the same

device type.)
true DALlidentifyalways is enabled
false DALlidentifyalways is disabled
DALImultidevice When multidevice is enabled MultiOne Workflow will allow multiple

devices of the same device type to be simultaneously configured.
When multidevice is enabled identifyalways also has to be enabled.

true DALImultidevice is enabled
false DALImultidevice is disabled
DALIcommissionall When commissionall is enabled MultiOne Workflow will commission

all connected devices. Also, when commission all is enabled the short
addresses of the connected devices are not reset anymore

true DALlcommissionall is enabled
false DALIcommissionall is disabled
DALIfactorynew When dalifactorynew is enabled MultiOne Workflow will reset the

short address of all connected devices, and perform a DALI reset after
configuring has finished
true DALlfactorynew is enabled
false DALlfactorynew is disabled

DALIcheckdevicepresent  When enabled MultiOne Workflow will do an additional check to
make sure that a device is connected before configuring the device.
This parameter will only do this additional check if the DALIverify and
DALlidentifyalways parameters are set to false and the selected
protocol is DALI.
true DALIcheckdevicepresent is enabled
false DALIcheckdevicepresent is disabled
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Notice! Before simultaneously configuring devices, at least one of the devices needs
to have a unique short address. Therefore, as part of configuring, short addresses
might need to be changed. In case such a change was needed all short addresses will
be reset to 255 after configuring. Remember that applications can be affected by a
change of the short address.

Examples of the workflow configuration file (a template for the configuration file can
also be found in the MultiOne Workflow installation directory):

For consecutive configuring For simultaneous configuring
checkdevicemodel = false checkdevicemodel = false
DALIverify = true DALIverify = false
DALIidentifyalways = true DALIidentifyalways = true
DALImultidevice = false DALImultidevice = true
DALIcommissionall = false DALIcommissionall = false
DALIfactorynew = true DALIfactorynew = true
DALIcheckdevicepresent = false DALIcheckdevicepresent = false

Notice! When using DALI, all the configuration parameters must be provided in the
file. When using SimpleSet, only the checkdevicemodel parameter must be provided
in the file. In case not all mandatory fields are provided, an error screen will be shown
in Workflow.

Notice! Files in c:\\Program Files or c:\Program Files (x86) can’t be edited by Windows
users who don’t have administrator privileges. It is recommended to choose a
different location for the workflow configuration file.

Notice! DALImultidevice in combination with Data logging isn't supported.
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8 The supported devices file

The supported devices file is a file that describes which devices are supported during
execution. If a connected device is not supported the execution fails. The supported
devices file is the same for MultiOne Workflow and MultiOne Command Line.

Example of the supported devices file (a template for the supported devices file can
also be found in the MultiOne Workflow installation directory):
<?xml version="1.0" encoding="utf-8"?>
<Products xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema" FileVersion="1.0">
<Product>
<ProductName>Xitanium 27W 1.0A Prog+ 230V J-sXt</ProductName>
<FactoryFirmwareVersion>V@1EQ1</FactoryFirmwareVersion>
</Product>
<Product>
<ProductName>HF-Ri TD 3 14/24 TL5 E+</ProductName>
<FactoryFirmwareVersion>1.4</FactoryFirmwareVersion>

</Product>
</Products>

The first line describes the xml version. This never changes.

The second line describes the xml schema used and the version of the supported
devices file. The xml schema specified is the default one and will never change. The
version of the supported devices file can change in the future.

Then, depending on the amount of supported devices for every supported device a
‘Product’ element must be specified. Within the ‘Product’ element there are two
subelements called ‘ProductName’ and ‘FactoryFirmwareVersion'. The ‘ProductName’
subelement holds the name of the product where the 'FactoryFirmwareVersion’ holds
the version of the product.
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9 Barcode reader and barcode requirements

To enable the possibility to automatically open files the following is required for the
barcode reader to be able to communicate with MultiOne Workflow:

- The barcode reader must be set to USB keyboard input mode (RS232 is not
supported) and to the same keyboard layout as the system it is connected to.

- The barcode reader must be configured to send a carriage return (CR) after a
scan.

For the barcode the following requirements are necessary:

- The barcode must contain the filename of the file, the extension of the file is
optional
- The barcode may only contain characters allowed by the Windows filesystem.

n

The following characters are not allowed: <, >,:, ", /,\, |, ?, and *.

Example of a 1D barcode for a Xitanium 40W 0.1-1.1A 54V 0-10V 120-277V 1.1
device:

X 0.1-1.14 34V 0100 120-277 1.1

tanium 400 0.1-1.14 54

Example of a 2D barcode (QR code) for the same Xitanium 40W 0.1-1.1A 54V 0-10V
120-277V 1.1 device:

El%:nE
]

[=]::

As you can see at the examples above a 1D barcode can get quite long, and some
barcode scanners won't be able to scan such long barcode anymore, so when using
long filenames it is recommended to use 2D barcodes instead.

To test if your barcode reader is setup correctly open Notepad and scan one of the
barcodes above. If notepad shows ‘Xitanium 40W 0.1-1.1A 54V 0-10V 120-277V 1.1’
and the cursor is at the beginning of the next line, then the barcode reader is setup
correctly.
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10 Label data file contents

When label data is generated and stored in a comma separated value file the

contents of the file consists of three lines. The first line contains the column names,

the second line contains the units and the third and line contains the values.

The following table describes which columns are included with which unit and its

value:
Column name Unit Value Included
Date dd- The date the label data was  Always
MM- generated
yyyy
Time Hh:mm  The time the label data was Always
generated
FeatureConfigurationFilePath  n/a The path to the feature Always
configuration file
FeatureConfigurationFileName n/a The name of the feature Always

Device Id n/a
Custom Field 1 n/a
Custom Field 2 n/a
Device Model n/a

configuration file

The unique identifier of the
device

Custom value 1

Custom value 2
Device model (for example:

Xitanium Outdoor 150W
.35 Prog+ H)

If configured to be
included

If configured to be
included

If configured to be
included

Always

If the driver contains one of the following features:

e AOC

e MTP

e Interface Selection
e Dynadimmer

Their settings are also stored in the label data file.
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11 Changes

Since version 1.0, the previous configuration file used by MultiOne Workflow located
in c:\temp\workflow.xml has been deprecated and will no longer be supported in a
future version of MultiOne Workflow (& Command Line).

We highly advice you to start using the new configuration file as described in 7 The
Workflow configuration file

Since version 3.0, the /i parameter has been deprecated and will no longer be
supported in a future version of MultiOne Workflow (& Command Line). It has been
replaced by the '/p’ parameter which specifies the protocol for communication and it
requires the same arguments as it predecessor.
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12 Copyright

Copyright © 2019 Signify Holding. All rights reserved.

All rights reserved. No part of this publication may be reproduced, transmitted,
transcribed, stored in a retrieval system or translated into any language or computer
language, in any form or by any means, electronic, mechanical, magnetic, optical,
chemical, manual or otherwise, without prior written permission from Signify. Brands
and product names are trademarks or registered trademarks of their respective
companies.
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13 Disclaimer

Signify makes no warranty of any kind with regard to this material, including, but not
limited to, the implied warranties of merchantability and fitness for a particular
purpose.

Signify assumes no responsibility for any error that may appear in this document.
Signify makes no commitment to update nor to keep current the information
contained in this document.
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14 Limitations of damages

The vendor will not be liable for any indirect, special, incidental or consequential
damages (including damages for loss of business, loss of profits, or the like), whether
based on breach of contract, tort (including negligence), product liability or
otherwise, even if the vendor or its representatives have been advised of the
possibility of such damages and even if a remedy set forth herein is found to have
failed its essential purpose.
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